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Executive summary KEY FINDINGS

Intel Corporation (Intel) commissioned Principled
Technologies (PT) to compare the performance on Microsoft
Windows Vista of an Intel vPro technology based PC with
that of three other platforms on common business
professional find/use/share scenarios. We tested four
scenarios that involve data security, finding and using
information, and real-time communication and collaboration
with Microsoft Office 2007 and other common office
applications. We compared the performance of the following
four platforms on these scenarios:

e The Intel® vPro™ technology based PC
with the Intel® Core™ 2 Duo processor
E6700 yielded significant performance
advantages for users on our business
professional find/use/share tests.

® The Intel vPro technology-based PC with
the Intel Core 2 Duo processor E6700
finished our four scenarios on average
1.50 times faster than the Intel®
Pentium® D processor 930-based PC.

® The Intel vPro technology based PC with
the Intel Core™ 2 Duo processor E6700
also finished our tasks on average 2.38
times faster than the Intel® Pentium® 4

e Intel Core 2 Duo processor E6700 on an Intel vPro
965 (DQY65GF) motherboard
e Intel Pentium D processor 930 on an Intel D945GTP

motherboard :
2.8GHz based PC with th
e Intel Pentium 4 processor 630 on an Intel D945GTP Fnrtc()acl:eDsgggGBF mf)tha:asr‘lioard il :
motherboard '

® These performance improvements
translate into multi-second time savings
that would be significant to users.

e Intel Pentium 4 processor 2.8GHz on an Intel
D865GBF motherboard

Figure 1 shows the normalized results for the foreground
tasks, the ones on which users typically wait for the system to respond, on all four test scenarios on all the test
systems. As it shows, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 significantly
outperformed the other PCs in all the test scenarios. The Intel vPro technology based PC with the Intel Core 2
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Figure 1: Normalized results for the foreground tasks on all test systems on all four scenarios. Larger numbers indicate
better performance.



Duo processor E6700 was from 1.15 times to 2.89 times faster on our foreground and background tasks than the
Intel Pentium D processor 930 based PC and averaged 1.50 times faster across all the tasks. (In all comparisons
in which we cite the average of task times, we use the geometric mean of the normalized times for each task.)

The Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was from 1.49 to 3.32 times
faster on our tests and averaged 2.38 times faster than the PC with the Intel Pentium 4 processor 2.8GHz on the
Intel D865GBF motherboard.

These performance improvements translated into multi-second time savings that users would notice and
appreciate. For example, the longest background task took 65.92 seconds on the Intel Pentium D processor 930 -
based PC but only 22.79 seconds--over 43 seconds faster--on the Intel vPro technology based PC with the Intel
Core 2 Duo processor E6700.

So that we could make the four test systems as similar as reasonably possible while varying the processors and
motherboards, we built the systems rather than purchasing them from vendors. Intel specified the general system
types and supplied the processors and motherboards. We purchased common such components as RAM, hard
disks, and optical drives. Each test system had the following basic components (see Appendix A for detailed
configuration information):

1GB of the fastest RAM its motherboard supported
80GB hard disk with an 8MB buffer (SATA)
DVD-RW optical drive

Microsoft Windows Vista Ultimate

We used the following common office and collaborative applications, which we list in alphabetical order:

Microsoft Office Groove 2007 (available only in Microsoft Office Enterprise 2007 Edition)
Microsoft Office Outlook 2007

Microsoft Office PowerPoint 2007

Microsoft Office Word 2007

We also used the following common security applications, which we list in alphabetical order:

e Windows Defender
o Windows Vista BitLocker Drive Encryption (available only in Windows Vista Ultimate or Windows Vista
Enterprise Editions)

The application scenarios we tested included such common functions as:

Opening files

Editing files

Receiving email

Syncing workgroup content
Copying encrypted folders
Scanning for malware

In the following sections we look more closely at our test application scenarios (Application scenarios), examine
the results of our tests (Test results and analysis), and give detailed information about how we actually performed
the tests (Test methodology). In the appendices, we present the configurations of the test systems and explain
how to manually execute the application functions in our scenarios.
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Application scenarios

We chose scenarios that involve common office applications and finding, using, and sharing business information.
Three of the scenarios involve Microsoft Office 2007 applications, while the fourth takes advantage of the new
BitLocker security feature available only in the Windows Vista Ultimate and Windows Vista Enterprise Editions.
Some scenarios involve a single task, while others involve multiple tasks running at the same time. In the
multitasking scenarios, we time both the foreground task (FG), which is typically a function that users initiate and
wait for the system to complete, and the background task (BG), which is usually a function users start and then
leave to run while they do other work.

Security anti-malware scenario: Creating a PDF with Microsoft Word while a Windows

Defender scan runs

Jenny Carlson, a quality assurance analyst in the science and math testing department at Acme Academics, had
shut down her computer while she was off-site at one of the regional grading centers. When she turns her system
on, it starts a Windows Defender scan that was scheduled by the IT department. She lets it run in the background
while she catches up on her work. One of Jenny’s supervisors has assigned her the task of developing a style
guide for the manuals their department provides for their educational and testing software. Jenny is evaluating a
sample manual she likes, the Microsoft Office 2003 installation guide. She plans to post her style guide on the
company’s intranet site once she finishes the document. The other documents accessible from that page are
PDFs, so she must also post in PDF format. Jenny is concerned about the size of the PDF files she will end up
posting, because her supervisor has strict rules about all files being reasonable sizes. Jenny opens the sample
document in Word and converts it to a PDF from within Word to get an idea of how big her style guide is likely to
be.

We timed:

e the PDF creation (FG) from when Jenny clicks the Publish button in the Publish as PDF or XPS
dialog box until Adobe Reader 7.08 completes loading the newly created PDF file
e the malware scan (BG), Windows Defender reports the scan time

Data security Windows Vista BitLocker encryption scenario: Copying a folder on an

encrypted volume

Luke Morningstar works as a research and development scientist at Glantec Pharmaceuticals. Nearly all of his
work is highly confidential and must be encrypted, so the IT department has employed Windows Vista’s BitLocker
technology to encrypt his entire hard disk partition. Thus, all of Luke’s work now occurs on an encrypted drive. He
is preparing to go through the test results files from one of Glantec’s latest clinical studies. Luke opens the folder
where he keeps a golden, unchanging version of those files and makes a working copy of them on his desktop.

We timed:

o the folder copy from when Luke right-clicks the BitLockerWorkload test folder and chooses Copy Here
until the dialog box with the progress bar disappears

Sales and marketing scenario with PowerPoint: Opening and editing a Microsoft

PowerPoint 2007 presentation

Sameer Gupta, the head of sales and marketing for educational testing at Acme Academics, has the task of
proposing to management the minimum PC configurations that the company will recommend to educational
institutions and testing centers. As preparation for his proposal, Sameer is studying a PowerPoint presentation of
test results comparing different types of PCs. He opens the PowerPoint deck and decides to change the
background of all of its slides to one he believes management will prefer.

We timed the following two tasks and then combined those times to produce the result we report:

o the file open from when Sameer opens the PowerPoint presentation by double-clicking the file on the
desktop until PowerPoint has completely rendered all the slides
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o the file edit from when Sameer changes the slide theme to until the last slide switches to the Apex
theme

Communications and collaboration scenario: Opening a compressed Outlook message
attachment, an XML file, in Microsoft Word 2007 while a Microsoft Groove 2007
workspace synchronization runs

Sheila Craig, an IT manager, is working on an internal audit of the systems at the Acme Academics grading
center. She has Microsoft Outlook running on her PC so she can receive an email she is expecting from her co-
worker, Jenny. Sheila checks her email and sees that Jenny has sent her the file she needs to study. The file is
an XML document that shows the advantages of some of the system upgrades Jenny is recommending for the
grading center. At the same time, someone has added a large group of files to the IT department’s Microsoft
Groove workspace. While Sheila is opening the attached zip file, Groove begins to automatically synchronize her
machine with the workspace. While the Groove synchronization runs in the background, Sheila opens Jenny’s
XML document in Word to study its contents.

We timed:

o the XML file open (FG) from when Sheila presses Enter to open the attached XML file until the file
open completes

e the Microsoft Groove sync (BG) from when Microsoft Office Groove 2007 launches until the content
sync countdown disappears

For more details on how we executed and measured these scenarios, our specific test functions, and the files the
scenarios use, see Appendix B.

Test results and analysis

In this section we examine the results of each of our tests. Figure 2 shows the times, in seconds, that each test
system needed to complete each scenario. The times we show for each platform for each scenario are from the
median run of the five test runs of that scenario on that platform. (We defined the median run as the one with the
median sum of the times of its timed tasks.)

Intel Intel vPro
Pentium 4 Intel Intel with Core 2
rocessor Pentium 4 Pentium D Duo
Tests p processor processor |processor
28GHzon 630 5 Intel 930 on Intel [E67
Intel on Inte on Intel [E6700 on
D865GBF D945GTP D945GTP Intel
DQY65GF
Security anti-malware
Creating a PDF with Microsoft Office Word 2007 (FG) 18.28 8.30 6.34 5.50
Windows Defender scan (BG) 39.00 25.00 21.00 18.00
Data security Windows Vista BitLocker encryption
Copying a folder on an encrypted volume | 64.00 | 35.01 | 31.79 | 26.34
Sales and marketing with PowerPoint
Opening and editing a MS PowerPoint presentation | 12.44 | 10.72 | 8.91 | 5.70
Communications and collaboration
Opening a compressed Outlook XML file attachment (FG) 20.15 19.49 22.01 13.56
Microsoft Groove 2007 sync (BG) 74.06 65.59 65.92 22.79

Figure 2: Median test times, in seconds, for all test systems on all four scenarios. Lower numbers are better.

In the following sub-sections we explore these results in more detail. To make comparisons easier, we always

show results normalized to those of the slowest system in the group, the Intel Pentium 4 processor 2.8 GHz-based
PC with the Intel D865GBF motherboard. To compute those normalized results, we divided each system’s time by
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the time it took the slowest system. The result for the Intel Pentium 4 processor 2.8GHz-based PC with the Intel
D865GBF motherboard is thus always 1.00, because it's the comparison basis. Results higher than 1.00 indicate
how much faster a system is than that system. Because of the normalization, higher result numbers are better.

For example, a result of 1.80 would mean the system in question was 80 percent faster than the Intel Pentium 4
processor 2.8GHz-based PC.
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Security anti-malware scenario: Creating a PDF with Microsoft Word 2007 while a

Windows Defender scan runs
As Figures 3 and 4 show, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was
1.15 times faster than the Intel Pentium D processor 930-based PC on the foreground task and 1.17 times faster
on the background task. Additionally, the Intel vPro technology based PC with the Intel Core 2 Duo processor
E6700 was 3.32 times faster than the PC with the Intel Pentium 4 processor 2.8GHz and the Intel D865GBF
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Figure 3: Normalized results for the Data backup and security scenario for all test systems. Larger

numbers indicate better performance.

motherboard on
the foreground
task and 2.17
times faster on the
background task.

As Figure 4
illustrates, these
differences can
represent
significant
improvements in
the time it takes to
perform each task.
For example,
compared to the
PC with the Intel
Pentium 4
processor 2.8 GHz
on the Intel
D865GBF
motherboard, the
Intel vPro
technology based

PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 18.28 to 5.50 seconds on the

foreground task and from 39.00 to 18.00 seconds on the background task.

PERFORMANCE RESULTS COMPARATIVE RATING
(seconds)
Intel Intel Intel m‘;’ é':’r‘; ) Intel Intel Intel wltt‘:" é':’r: )
Pentium 4 |Pentium 4 |PentiumD Pentium 4 |Pentium4 |PentiumD
Duo TASKS Duo
processor |processor |processor rocessor processor |processor |processor brocessor
2.8 GHz on (630 on 930 on 26700 on 2.8 GHz on (630 on 930 on E6700 on
Intel Intel Intel intel Intel Intel Intel intel
D865GBF |D945GTP D945GTP DQ965GF D865GBF |D945GTP D945GTP DQ965GF
Foreground:
18.28 8.30 6.34 5.50 Creating a PDF 1.00 2.20 2.88 3.32
with Word
Background:
39.00 25.00 21.00 18.00 Windows 1.00 1.56 1.86 217
Defender scan

Figure 4: Results for the Security anti-malware scenario for all test systems. Lower performance results are better. Higher
comparative ratings are better.
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Data security BitLocker encryption scenario: Copying a folder on an encrypted volume
Figures 5 and 6 demonstrate that the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700
was 1.21 times faster on this test than the Intel Pentium D processor 930-based PC and 2.43 times faster than

the PC with the
Intel Pentium 4
processor 2.8GHz

on the Intel
D865GBF
motherboard.
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Figure 5: Normalized results for the Data security BitLocker encryption scenario for all test systems.

Larger numbers indicate better performance.

motherboard, the
Intel vPro
technology based

PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 64.00 to 26.34 seconds.

PERFOR("::c'ﬁESESULTS COMPARATIVE RATING
Intel Intel Intel wltt(;l é’::g 2 Intel Intel Intel wittil é':,:z 2
Pentium 4 (Pentium4 |PentiumD Duo TASK Pentium 4 (Pentium4 |[PentiumD Duo
processor |processor processor brocessor processor processor processor processor
intol " linl - [intol . [ESTO0on intel " lintel . |intor . ES7000n
D865GBF D945GTP D945GTP DQ9E5GF D865GBF D945GTP D945GTP DQ965GF
Copying a
64.00 35.01 31.79 2634 | e on 1.00 1.83 2.01 2.43
volume

Figure 6: Results for the Data security BitLocker encryption scenario for all test systems. Lower Performance Results are better.

A higher Comparative Rating is better.

The Intel vPro technology-based PC with the Intel Core 2 Duo processor E6700 used the built-in TPM 1.2 chip for
BitLocker key storage. The three other systems stored the BitLocker key on a USB flash drive during BitLocker
configuration; we removed the flash drive once Windows Vista recognized the BitLocker key and a USB flash
drive removal prompt appeared. (Though the two systems with the Intel D945GTP motherboard support TPM,
Windows Vista would not work with TPM on them.)
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Sales and Marketing scenario with PowerPoint: Opening and editing a Microsoft
PowerPoint 2007 presentation
Figures 7 and 8 illustrate the results of this test, which involves a common and simple set of operations with
Microsoft PowerPoint 2007. The Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was
1.56 times faster than the Intel Pentium D processor 930-based PC and 2.18 times faster than the PC with the
Intel Pentium 4 processor 2.8GHz on the Intel D8B65GBF motherboard.
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Figure 7: Normalized results for the Sales and marketing scenario with PowerPoint for all test systems.
Larger numbers indicate better performance.

PERFORMANCE RESULTS

COMPARATIVE RATING

(seconds)
Intel Intel Intel In_tel vPro Intel Intel Intel In_tel vPro
. . . with Core 2 . . . with Core 2
Pentium 4 |Pentium 4 |PentiumD TASKS Pentium 4 |Pentium4 |PentiumD
Duo Duo
processor |processor |processor brocessor processor |processor |processor brocessor
intel o |intel | intel | [S7000n N O i
D865GBF |D945GTP D945GTP DQIG5GF D865GBF |D945GTP D945GTP DQ965GF
Opening and
12.44 10.72 8.91 570 | poaurga 1.00 1.16 1.40 2.18
presentation

Figure 8: Results for the Sales and Marketing scenario with PowerPoint for all test systems. Lower performance results are
better. Higher comparative ratings are better.
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Communications and collaboration scenario: Opening a compressed Outlook message
attachment, an XML file, in Microsoft Word 2007 while a Microsoft Groove workspace

synchronization runs
As Figures 9 and 10 show, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was
1.62 times faster than the Intel Pentium D processor 930-based PC on the foreground task and 2.89 times faster
on the background task. Additionally the Intel vPro technology based PC with the Intel Core 2 Duo processor
E6700 was 1.49 times faster than the PC with the Intel Pentium 4 processor 2.8GHz and the Intel D865GBF
motherboard on the foreground task and 3.25 times faster on the background task.
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Figure 9: Normalized results for the Communications and collaboration scenario for all test systems.
Larger numbers indicate better performance.

As Figure 10
shows, these
differences
represent
significant
improvements in
the time it takes to
perform each task.
Compared to the
Intel Pentium D
processor 930-
based PC, the
Intel vPro
technology based
PC with the Intel
Core 2 Duo
processor E6700
decreased the
elapsed time from
22.01 to0 13.56
seconds on the
foreground task
and from 65.92 to
22.79 seconds on

the background task. Compared to the PC with the Intel Pentium 4 processor 2.8GHz on the Intel D865GBF
motherboard, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the
elapsed time from 20.15 to 13.56 seconds on the foreground task and from 74.06 to 22.79 seconds on the

background task.
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PERFORMANCE RESULTS

COMPARATIVE RATING

(seconds)
Intel Intel Intel In_tel e Intel Intel Intel In_tel e
. . . with Core 2 . . . with Core 2
Pentium 4 |Pentium 4 |PentiumD Duo TASKS Pentium 4 |Pentium4 |PentiumD Duo
processor |processor |processor | . processor |processor |processor | ..
2.8 GHz on (630 on 930 on 26700 on 2.8 GHz on |630 on 930 on 26700 on
Intel Intel Intel intel Intel Intel Intel intel
D865GBF |D945GTP D945GTP DQ9E5GF D865GBF |D945GTP D945GTP DQ965GF
Foreground:
Opening a
20.15 19.49 22.01 13.56 compressed 1.00 1.03 0.92 1.49
Outlook XML
file attachment
Background:
Microsoft
74.06 65.59 65.92 22.79 Groove 2007 1.00 1.13 112 3.25
sync

Figure 10: Results for the Communications and collaboration scenario for all test systems. Lower performance results are
better. Higher comparative ratings are better.
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Test methodology

Setting up the test systems
To get the most accurate and repeatable results possible, start with a clean hard disk and set up all the test
systems using the following procedures.

Installing Microsoft Windows Vista Ultimate
Use the following process to install a clean version of Windows Vista Ultimate on each system under test:

1. Install Windows Vista Ultimate Build 6000.
Boot to a Windows Vista Ultimate Build 6000 DVD.
When prompted, press any key to boot from CD or DVD.
At the language and preference screen, accept the default options, and click Next.
Click Install now.
Do not enter a Product key. Uncheck Automatically activate Windows when I’'m online, and click Next.
At the Do you want to enter your product key now screen, click No.
Select Windows Vista Ultimate, and check | have selected the edition of Windows that | purchased.
Click Next.
Check | accept the license terms.
Click Next.
At the Which type of installation do you want screen, select Custom (advanced).
Click Drive options (advanced).
. Select the destination Disk for the operating system.
Click Format.
Click OK at the all data stored will be permanently deleted dialog.
Once the system finishes formatting the disk, click Next.
Fill in the Username and Password fields, and click Next.
Fill in the computer name field, and click Next.
When presented with the option to enable Automatic Updates, click Ask me later.
Select the correct time zone, date, and time, and click Next.
At the Select your computer’s current location screen, click Public location.
Click Start at the Thank you screen.
When the Windows Vista Ultimate installation completes, close the Welcome Center Dialog.
At the Set network location screen, click Public location.
. Click Close.
2. Set the test resolution.
a. Right-click on the desktop.
b. Select Personalize.
c. Click Display Settings.
d. If the monitor resolution is not already 1280 by 1024, adjust it to that setting.
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e. Click OK.
3. Verify that Windows Automatic Updates are off.
a. Click Start.

b. Select Control Panel.

c. Click Security.

d. Under Security Center, select Turn automatic updating off.
e. Select the Never check for updates radio button.

f

Click OK.
4. Turn off System Restore. Doing so prevents such events from occurring during testing and affecting
results.
a. Click Start.
b. Right-click Computer.
c. Select Properties.
d. Select System protection on the left.
e. Click Continue.
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f.  Uncheck each box under Automatic restore points.
g. Select Turn System Restore Off at the System Protection pop-up window.
h. Click OK.
5. Add the system to the test domain.
Click Start.
Right-click Computer
Select Properties.
Select Change settings.
Click Continue.
Click Change.
Select the Domain radio button.
Type the test domain name.
Click OK.
Type the administrator credentials in the User name and Password fields.
Click OK.
Click OK at the Computer Name/Domain Changes dialog box.
. Click OK again.
Close the System Properties window.
Close all other open windows before clicking Restart Now.
Log in.
Uncheck the Run at startup box on the Welcome Center before closing it.
dd the user to the Administrators group.
Click Start.
Right-click Computer.
Select Manage.
Click Continue.
Select Local Users and Groups on the left.
Double-click Groups in the center.
Select Administrators.
Click Add..., and type the domain test user account.
Click OK.
Type the administrator credentials in the User name and Password fields.
Click Apply.
Click OK.
Close all windows.
Click Start.
Click the arrow->.
Select Log Off.
Press Ctrl + Alt + Delete at the prompt.
Click Switch User, and select Other User.
Type the test user’s credential in the User name and Password fields.
Press Enter.
urn all Power Management settings to Performance.
Click Start.
Select Control Panel.
Select Appearance and Personalization.
Under Personalization, click Change screen saver.
Select (None) from the Screen saver drop-down menu.
Click the Change power settings link.
Click the High performance radio button.
Select Never for the Turn off the display and Put the computer to sleep drop-down menus.
Click Change advanced power settings.
Click Hard disk->Turn off hard disk after>Setting (Minutes), then type Never.
Scroll down, and click Sleep->Sleep after-> Setting (Minutes), and type Never.
Click Sleep—>Allow Hybrid Sleep-> Setting.
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Select Off.

Scroll down, and click Display-> Turn off display after-> Setting, then type Never.
Click OK.

Click Save changes.

Close the Power Options window.

Click OK on the Screen Saver Settings.

Installing Adobe Acrobat Reader 7.0.8
Use the following process to install a clean version of Adobe Acrobat Reader 7.0.8:

1.
2.

Download Adobe Acrobat Reader 7.0.8 from: http://www.adobe.com/products/acrobat/readstep2.html.
Install Adobe Acrobat Reader 7.0.8 with default settings.

S@ ™t a0 T

Double-click the Adobe Acrobat Reader executable.
Click Run at the Security Warning screen.

Click Continue.

Click Next at the Setup screen.

Click Next at the Welcome screen.

Accept the default installation path, and click Next.
Click Install.

Click Finish.

Installing Adobe Flash Player 9.0
Use the following process to install a clean version of Adobe Flash Player 9:

1.

Install Adobe Flash Player 9 from
http://www.adobe.com/shockwave/download/download.cgi?P1 Prod Version=ShockwaveFlash&promoid

=BIOW.

a.
b.
c.
d.

Uncheck the box next to YAHOO! toolbar, and click Install Now.

Click Continue at the User Account Control dialog.

Click Install at the Security Warning dialog.

Flash Player is successfully installed when the flash installation completion movie plays.
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Setting up the test network

To mimic the environment in which business PCs run, we set up a test network with servers handling Microsoft
Exchange, Microsoft Active Directory, Microsoft Office Groove Manager, and Microsoft Groove Relay. Figure 12
shows a basic diagram of this test network.

100MB Ethernet

Switch
Windows Server 2003 R2 Enterprise X64 Edition % -
Active Directory/DNS/DHCP @
—_ Collaboration Client
Windows Vista

Windows Server 2003 R2 Enterprise Edition
Exchange Server 2003 Enterprise Edition with SP2

!
g

System Under Test
Windows Vista

///o

Windows Server 2003 R2 Enterprise x64 Edition
Microsoft Office Groove Manager Server 2007 Beta 2
Microsoft SQL Server 2005 Enterprise Edition x64

100MB Ethernet
connection

Windows Server 2003 R2 Enterprise x64 Edition
Microsoft Office Groove Relay Server 2007 Beta 2

Figure 11: Diagram of the test network.

Appendix A provides configuration details for both the systems we tested and the other systems in this test
network.

The follow subsections outline how to set up the servers in this network.
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Settlng up the Active Directory/DNS/DHCP server
Install Windows Server 2003 R2, Enterprise x64 Edition on the server.
Insert and boot from the HP SmartStart 7.60 CD.
Select English (the default), and click Continue.
At the SmartStart Home screen, click Deploy Server.
At the Server Deployment — Hardware Configuration screen, click Continue.
At the Server Deployment — Operating System Selection screen, expand Microsoft Windows 2003
and select Microsoft Windows Server 2003 R2, Enterprise x64 Edition. Click Continue.
At the Server Deployment — Operating System Media Source screen, select CD-ROM as the source
type and Flat files as the source format. Click Continue.
At the Server Deployment — Disk Partitioning Options screen, click Continue.
At the Server Deployment — Operating System Configuration Information screen, enter the User
Name, Organization Name, and Product Key.
Set License Type to Per Seat (the default), and click Continue.
At the Server Deployment — SNMP Configuration screen, click Continue.
At the Server Deployment — Ready to Install screen, click Continue. Setup will begin.
The setup program will prompt you at the Server Deployment screen to Please insert the operating
system media and click Continue. Insert the Microsoft Windows Server 2003 R2 Enterprise Edition
CD Disc 1 into the CD-ROM drive, and click Continue. Setup will verify the media and begin copying
data files. Once setup finishes copying the files it needs your system will automatically reboot.
2. Set the Administrator account password to Password1, the server name to SERVER1-AD, and the
Workgroup to ACME.
3. Disable the second network card by right-clicking the taskbar icon and selecting disable.
4. Set the server name and give this server a unique static IP address. (The IP addresses in these
instructions are simply samples; your IP addresses will depend on your domain.)
Name: SERVER1-AD
IP Address: 192.168.0.1
Subnet mask: 255.255.255.0
Default gateway: 192.168.0.254
DNS: 192.168.0.1
Workgroup: ACME
5. Install the latest security updates from the Windows Update site.
6. Set up Active Directory.
a. From Manage Your Server, click Add or remove a role.
b. Click Next.
c. Ifyou have 1 or more network connections that are disconnected, you will receive a warning message
stating that fact. Cick Continue if this message appears.
d. From the Configuration Options screen, select Typical configuration for a first server, and click Next.
e. The Active Directory domain name will default to ACME.local; accept this name, and click Next.
f. The NetBIOS domain name will default to ACME; accept this name, and click Next.
9
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At the summary, click Next.
Click OK when the restart message screen appears.
Insert the Windows 2003 Disc 1 CD when the system prompts you to do so. Your server reboot
automatically during this setup process.
j. Once it reboots, login and click Next when the Configure Your Server Wizard appears.
k. Click Finish. Installation is now complete.
7. Configure Active Directory setup by changing the domain mode from Windows 2000 mixed to Windows
Server 2003.

a. Open Start->Administrative Tools->Active Directory Users and Computers.
b. Right-click the ACME.local domain from the list.
c. Select Raise Domain Functional Level.
d. In the drop-down menu, select Windows Server 2003, and click Raise.
e. Click OK when the warning screen appears.
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8. Set up the router address in DHCP.

a. Open Start->Administrative Tools->DHCP.

b. Expand the domain.

c. Right-click Server Options, and select Configure Options.

d. From the General tab, select the 003 Router option, and make sure it is checked.

e. Inthe Data entry frame, in the IP address: field, enter the IP address of the router (192.168.0.254).
f. Click Add.

g. Click OK.

Setting up the Exchange server
1. Install Windows Server 2003 R2 Enterprise Edition on the server.

Insert and boot from the HP SmartStart 7.60 CD.

Select English (the default), and click Continue.

At the SmartStart Home screen, click Deploy Server.

At the Server Deployment — Hardware Configuration screen, click Continue.

At the Server Deployment — Operating System Selection screen, expand Microsoft Windows 2003

and select Microsoft Windows Server 2003 R2, Enterprise Edition. Click Continue.

At the Server Deployment — Operating System Media Source screen, select CD-ROM as the source

type and Flat files as the source format. Click Continue.

At the Server Deployment — Disk Partitioning Options screen, click Continue.

At the Server Deployment — Operating System Configuration Information screen, enter the User

Name, Organization Name, and Product Key.

Set License Type to Per Seat (the default), and click Continue.

At the Server Deployment — SNMP Configuration screen, click Continue.

At the Server Deployment — Ready to Install screen, click Continue. Setup will begin.

The setup program will prompt you at the Server Deployment screen to Please insert the operating

system media and click Continue. Insert the Microsoft Windows Server 2003 R2 Enterprise Edition

CD Disc 1 into the CD-ROM drive, and click Continue. Setup will verify the media and begin copying

data files. Once setup finishes copying the files it needs your system will automatically reboot.

2. Set the Administrator account password to Password1, the server name to SERVER2-EX, and the
Workgroup to ACME.

3. Disable the second network card by right-clicking the taskbar icon and selecting disable.

4. Set the server name and give this server a unique static IP address. (The IP addresses in these
instructions are simply samples; your IP addresses will depend on your domain.)

Name: SERVER2-EX

IP Address: 192.168.0.2

Subnet mask: 255.255.255.0

Default gateway: 192.168.0.254

DNS: 192.168.0.1

Workgroup: ACME

5. Install the latest security updates from the Windows Update site.

6. Add SERVER2-EX to the ACME domain.
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Click Yes to restart.

After restart, press Ctrl-Alt-Delete at the login screen and click Options.
j. Select the ACME domain, and login as Administrator.

7. Set up Microsoft Internet Information Services (IIS) 6.0. (You must set up IIS on the server before you
install Microsoft Exchange Server 2003.)

a. Go to Control Panel->System.

b. On the Computer Name tab, click Change.

c. Select Domain, and enter ACME.local as the domain. Click OK.

d. When prompted, enter the username Administrator and the password Password1, then click OK.
e. Click OK.

f. Click OK.

g. Click OK.

h.

i.
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a. Toinstall 1IS 6.0 on Windows 2003 Enterprise or Standard Edition, use Add or Remove Programs in
the Windows Control Panel.
b. Choose Add/Remove Windows Components.
c. Select the Internet Information Services (IIS) component
8. Installing Exchange Server 2003 Enterprise Edition.
a. Insert the Exchange Server 2003 Enterprise Edition CD.
b. Click Exchange Deployment Tools.
c. Accept all default settings, and finish with the install.

9. Install Exchange Server 2003 SP2 with the default installation options.

10. Set up the user accounts. (The scenario tests require one user account for each system under test, plus
an account for the collaboration scenario client.) To do this, run Active Directory Users and Computers
from the Administrative Tools menu, and add the user accounts. Active Directory and Exchange will
automatically assign each user an Exchange email address.

Setting up the server for Groove Manager/SQL server
1. Install Windows Server 2003 R2 Enterprise x64 Edition on the server.

a. Insert and boot from the HP SmartStart 7.60 CD.

b. Select English (the default), click Continue.

c. Atthe SmartStart Home screen, click Deploy Server.

d. Atthe Server Deployment — Hardware Configuration screen, click Continue.

e. Atthe Server Deployment — Operating System Selection screen, expand Microsoft Windows 2003
and Select Microsoft Windows Server 2003 R2, Enterprise x64 Edition. Click Continue.

f. At the Server Deployment — Operating System Media Source screen, select CD-ROM as the source
type and Flat files as the source format. Click Continue.

g. Atthe Server Deployment — Disk Partitioning Options screen, click Continue.

h. At the Server Deployment — Operating System Configuration Information screen, enter the User
Name, Organization Name, and Product Key.

i. Set License Type to Per Seat (the default). Click Continue.

j- At the Server Deployment — SNMP Configuration screen, click Continue.

k. Atthe Server Deployment — Ready to Install screen, click Continue. Setup will begin.

l.

The setup program will prompt you at the Server Deployment screen to Please insert the operating

system media and click Continue. Insert the Microsoft Windows Server 2003 R2 Enterprise Edition

CD Disc 1 into the CD-ROM drive, and click Continue. Setup will verify the media and begin copying

data files. Once setup finishes copying the files it needs your system will automatically reboot.

2. Set the Administrator account password to Password1, the server name to SERVER3-GS, and the
Workgroup to ACME.

3. Disable the second network card by right-clicking the taskbar icon and selecting disable.

4. Set the server name and give this server a unique static IP address. (The IP addresses in these
instructions are simply samples; your IP addresses will depend on your domain.)

Name: SERVER3-GS

IP Address: 192.168.0.3

Subnet mask: 255.255.255.0

Default gateway: 192.168.0.254

DNS: 192.168.0.1

5. Install the latest security updates from the Windows Update site.

6. Add SERVERS3-GS to the ACME domain.

Go to Control Panel->System.

On the Computer Name tab, click Change.

Select Domain, and enter ACME.local as the domain. Click OK.

When prompted, enter the username Administrator and the password Password1, then Click OK.

Click OK.

Click OK.

Click OK.

Click Yes to restart.

After restart, press Ctrl + Alt + Delete at the login screen, and click Options.
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j. Select the ACME domain, and login as Administrator.
7. Set up Microsoft I1S 6.0.
a. Toinstall lIS 6.0 on Windows 2003 Enterprise or Standard Edition, use Add or Remove Programs in
the Windows Control Panel.
b. Choose Add/Remove Windows Components.
c. Select the Internet Information Services component.
d. From IS, enable SMTP and configure it so that administrators can send email containing account
configuration codes to Groove users.
8. Install Microsoft SQL Server 2005 Enterprise Edition x64.
a. Insert the Microsoft SQL Server 2005 Enterprise Edition x64 CD-ROM drive. The installation wizard
will automatically appear.
b. At the Feature Selection Setup Screen, select:
i. Database Services
ii. Integration Services
iii. Client Components
For Instance Name, select the Default, and click Next.
At Service Account, select Use the built-in System account, chose Local system, and click Next.
At the Authentication Mode, select Mixed Authentication Mode, and click Next.
For the Collation Settings screen, keep all the default settings, and click Next.
For Error and Usage Report Settings screen, leave both check boxes unchecked, and click Next.
At the Ready to Install screen, click Install.
i.  When the Installation Complete screen appears, click Finish.
9. Run Windows Update again and install any new security updates.
10. Install and configure the Microsoft Groove Manager.
a. Insert the Microsoft Office Groove Server Beta 2 CD into the drive.
b. Select the option to install Microsoft Office Groove Server 2007 Groove Manager.
c. Follow the Setup instructions and enter the product ID key code when the installation software
prompts you to do so.
d. Accept the Microsoft license agreement.
e. Once the Office components and settings are installed, select the Basic installation option.
f.  When the Groove Manager Configuration wizard starts, enter the following Groove Manager
configuration information:

@ me oo

Administrator E-mail Address jcarlson@ACME .local
Organization Name ACME

http://server3-
URL of Groove Manager Server gs.acme.local
Certification Authority Name server3-gs.acme.local
Configure Groove Audit Server
Components Do not select this option

g. Click Next.

h.  When the system prompts you to do so, enter the following SQL Server information. (The Groove
Manager uses this information to establish a connection to the database server on which the Groove
Manager depends for data storage. Give the account administrative permissions on the database.)

Use the Following SQL Server Login Select this checkbox.
User Name Administrator
Password Password1
SQL Server Name server3-gs.acme.local
Accept the default name
Database Name (gmsDb)
i. Click Next.

j.  Follow the Install wizard to the end, accepting defaults, and click Finish.

11. To access the Groove Manager administrative Web interface, follow these steps:
a. Open an Internet Explorer browser.
b. Enter the URL for the Groove Manager site (http://server3-gs).
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k.

Log in with the username Administrator and the password Password1.

Select Members from the navigation pane.

Click Add Members in the toolbar. A list of user deployment options appears.

Click Add Single Member, then click Next. The Select Member Settings page appears.

From the Select Member Settings page, accept the default policy templates and relay server sets.

Click Next. The Add Single Member page appears.

From the Add Single Member page, type the user data into the fields to create the following two

identities the test scenarios require. This data will appear in the user’'s Groove Contact Properties.
i. Full name - Jenny Carlson

ii. Email address - jcarlson@acme.local

Click the Save and Create Another button to repeat the above process for the next user.

i. Full name - Sheila Craig

ii. Email address scraig@acme.local

When you finish adding member information, click the Finish button.

12. Send a Groove account configuration code with its associated identity information to Groove users from a
Groove Manager email message.

a.
b.
c.
d

e.

From the Members page, select target recipients for the email.

Click the top check box to select all users.

Select the Manage Members drop-down menu in the toolbar.

Click Send Groove Account Configuration Code. The Send Groove Account Configuration Code

window appears with an email form that shows any default email.

Enter the following information in the fields on the default email page:

i. Select Sample account configuration email to display the initial default account restoration email.

ii. Enter administrator@acme.local as the email address.

ii. Enter Groove for the email subject.

v. Click the Send button. This sends the email, along with the Account configuration code for the
individual Groove accounts.

Setting up the Groove Relay server
1. Install Windows Server 2003 R2 Enterprise x64 Edition on the server.

a. Insert the Windows Server 2003 R2 Enterprise x64 Edition CD.

b. When a screen appears prompting you to press any key to boot from the CD, press any key.

c. Press Enter at the Welcome to Setup screen to setup Windows Server 2003.

d. Press F8 at the Windows License Agreement screen.

e. If a previous version of Windows Server was installed on the drive, the installation software will ask if
you would like to repair the damaged installation. Press Esc to continue installing a fresh copy of
Windows without repairing.

f. Atthe Windows Server 2003 Setup screen, delete any existing C: partitions by selecting the partition
to delete and pressing the D key.

g. Hit Enter to confirm the deletion.

h. Press L to confirm the deletion.

i.  You will return to the Windows Server 2003 Setup screen. Select the Unpartitioned Space, and press
Enter.

j.  Using the arrow keys, select Format the partition using the NTFS file system (Quick), and press
Enter.

k. Once the formatting and the file copy complete, the installation software will prompt you to restart the
system. Press Enter to restart.

I. A Windows Server 2003 loading screen and then a Windows installation screen will appear.

m. Click Next at the Regional and Language Options screen.

n. At the Personalize Your Software screen, enter Server as the name, leave the organization field
blank, and click Next.

o. Atthe Your Product Key screen, type the product key. and click Next.

p. Leave the default settings at the Licensing Modes screen, and click Next.

gq. For computer name, type Server5-GR, and for administrator’s password, type Password1. Type
Password1 to again confirm. Click Next.

Principled Technologies, Inc.: System performance in common 19

professional find/use/share scenarios in Microsoft Windows Vista



r. Atthe Date and Time Settings screen, select the current date and time and the (GMT -05:00) Eastern
Time (US and Canada) time zone. Leave the Automatically adjust clock for daylight savings changes
checked, and click Next.
Windows Server 2003 will automatically complete the installation process and restart the server.
Press Ctrl + Alt + Delete after the system restarts.
Log on to windows using the password you selected earlier.
At the Windows Setup Screen, the installation software will ask you to insert the Windows Server
2003 CD 2. Insert the CD, and click OK.
At the Windows Server 2003 R2 Setup Wizard Welcome Screen, click Next.
At the Windows Server 2003 R2 Setup Wizard Setup Summary, click Next.
The installer will copy more files to the server. When the Windows Server 2003 R2 Setup Wizard
Completing Windows Server Setup screen appears, click Finish.
z. Atthe Windows Server Post-Setup Security Updates screen, click Finish.
aa. At the Windows Server Post-Setup Security Updates WARNING pop-up, click Yes to close the page.
bb. At the Manage Your Server screen, check the box next to Don’t display this page at logon, and click
the X in the top right corner to close the screen.
2. Set Administrator account password to Password1, the server name to SERVERS-GR, and the
Workgroup to ACME.
3. Set the server name and give this server a unique static IP address. (The IP addresses in these
instructions are simply samples; your IP addresses will depend on your domain.)
e Name: SERVER5-GR
e |P Address: 192.168.0.5
e Subnet mask: 255.255.255.0
[ ]
[ ]
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Default gateway: leave blank
DNS: 192.168.0.1
4. Add SERVERS5-GR to the ACME domain:

Click Yes to restart.
After restart, press Ctrl + Alt + Delete at the login screen, and click Options.
Select the ACME domain, and login as Administrator.
5. Configure the system performance options.
Open the System control panel applet, and click the Advanced tab.
Click the Performance Options button.
In the Optimize performance for field, select Background services.
Click the Change button to display the Virtual Memory options.
Set the initial virtual memory to 8192MB and the maximum to 16384MB.
Click OK.
onfigure each external network connection on the server.
Right-click My Network Places, then select Properties to open the Network Connections window.
Right-click the network interface card that you want to edit, and select Properties.
Disable the Client for Microsoft Networks component.
Disable the File and Printer Sharing for Microsoft Networks component.
If the Internet Protocol (TCP/IP) component is not already enabled, enable it.
Disable NetBIOS over TCP/IP by selecting Internet Protocol (TCP/IP), pressing the Properties button,
clicking the Advanced button to open the Advance TCP/IP Settings window, clicking the WINS tab,
and then selecting the Disable NetBIOS over TCP/IP option.
Click the DNS tab, and make any changes necessary to support your network configuration.
Click the IP Settings tab, and make any necessary changes to support your network configuration.
i.  Click OK until you return to the Network and Dial-Up Connections window.

a. Go to Control Panel>System.

b. On the Computer Name tab, click Change.

c. Select Domain, and enter ACME.local as the domain. Click OK.

d. When prompted, enter the username Administrator and the password Password1. Click OK.
e. Click OK.

f.  Click OK.

g. Click OK.

h.

i.
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7. Install the latest security updates from the Windows update site.
8. Install Groove Relay server:
a. From the Windows server machine, insert the Microsoft Office Groove Server 2007 Beta 2 CD into
the drive.
b. Select the option to install Microsoft Office Groove Server 2007 Groove Relay. (The installation
instructions are in the GettingStarted.htm file in the \grs subdirectory of the installation media. The
Groove Relay Administrators Guide and release notes are also in this directory).
c. Start the setup program by double-clicking the Groove Relay Setup link in the Getting Started.htm file.
d. Follow the Setup wizard instructions. Entering the product ID key code when the installation software
prompts you to do so.
e. If the Microsoft Installer must be updated, the update will occur at this point. If it occurs, you will have
to reboot the server. After reboot, manually start the setup process and continue.
f.  Accept the Microsoft license agreement.
g. When the installation of the Office components and settings completes, choose Advanced installation.
h. Select the Programs component, then click the Change button to override the default installation
directory.
i. Click Next
Click the Change buttons to edit the paths for the Database and log files. Set the database and log
files to use the path F:\Groove Relay\Data.
k. Click the Feedback tab, and select No thank you.
[.  Click Next 3 times.
m. Click Install.
n. Click Finish to install the Groove Relay. The installer now launches the Groove Relay Configuration
control panel applet.
9. Identify the Groove Relay and Generating Groove Relay Key Files to enable the secure provisioning of
managed Groove users to the Groove Relay.
a. If the Groove Relay Configuration control panel applet is not already open, do the following:
i. Open the Control Panel from the Start menu.
i. Double-click the Groove Relay Configuration control panel applet.
b. From the Server tab, set the field values as in the following table:

—

Relay Server Name server5-gr.acme.local
Administrative User Name |Administrator

Administrative Realm server5-gr@acme.local
Administrative Password |Passwordl

Private Key File Name Default: privkey.dat
Certificate File Name Default: ServerCertificate.cer
Unattended Startup Default: selected (enable unattended startup)

c. Enter the Administrative Password, and generate the Groove Relay private key and certificate files by
clicking the Generate Files button.
d. Click Next. (This button will not be available if you have not completed all the required fields.)
10. Configure the Groove Relay SOAP interface for communications between the Groove Relay and Groove
Manager servers.
a. From the Groove Relay Configuration control panel applet SOAP tab, enter the information in the
fields as in the following table:

Relay SOAP

Interface http://server5-gr.acme.local

Name

Private Key Accept the default file name.

File Name Default: ServerSOAPKeyStore.xml

Certificate Accept the default file name, then click the Generate Files button to create the private key and certificate files.
File Name

Default: ServerSOAPCertificate.cer
Export ID Accept the default name of the Serverid.xml file, then click the Export ID File button to generate the file and update the
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C.

d.

File Name following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office Server\Groove\Groove Relay\Parameters

Remember where you save this file. You must specify the location of this file in the Groove Manager administrative Web
interface so you can upload it to the Groove Manager server.

To identify the Groove Manager to the Groove Relay, you must copy the Groove Manager's registry key file
(ManagementServer.reg) to the Groove Relay and install it in the local registry. Only Groove Manager servers whose registry
keys are written to the Groove Relay can communicate with the Groove Relay. Successful upload of the ServerID file to Groove
Manager and the writing of the Groove Manager registry file to the Groove Relay are necessary to enable and secure
communication between the two servers.

Default: serverID.xml

Once you have generated the SOAP private key and certificate files by clicking the Generate Files
button and clicked the Export ID File button, click the Next button to continue to the Security tab.
Click the Finish button to complete the initial Groove Relay server configuration and exit the control
panel.

A pop-up window appears and prompts you to back up the newly generated key files. Insert a USB
drive or other removable media and click OK.

11. Start the Groove Relay server.

a.

b.

c.
12. Add

a.

b.

c.

@™o

m.

n.
13. Res
a.
b.
C.

Go to Start>Programs—>Administrative Tools—> Services.

Right-click the service Groove Relay, and click Start.

To test the server installation, open a browser and enter the URL http://localhost:8010/.

the Relay Server to the Groove Manager.

From the Groove Relay server, open a browser, and enter http://server3-gs/gms/.

On the navigation pane, click the domain Relay Server Sets heading.

The Relay Server Sets tab appears with a list of relay server sets. The Groove Manager provides an
initial default relay server set, which is empty if you have not added servers to the set.

Click the Relay Servers tab.

Click Add Server in the toolbar

Select Onsite Relay Server for the Groove Relay.

From the Add Relay Server page, click the Download Public Key button to download
ManagementServer.reg. The File Download dialogue box appears. This .reg file contains the Groove
Manager's certificate with its public key and identifying information.

Select Save this file, and then click OK.

Select a location for saving the file (c:\ drive).

Click the Save button.

Click the Close button.

From the Groove Relay server, double-click the c:\ManagementServer.reg file to update the Groove
Relay registry.

From the Add Relay Server page on the Groove Manager, browse to the location of the Groove Relay
ID file (serverID.xml) which you generated and saved to removable media above.

Click OK to upload the Groove Relay ID file to the Groove Manager domain.

tart the Groove Relay server.

From the Relay server, go to Start->Programs->Administrative Tools-> Services.

Right-click the service Groove Relay, and click Restart.

To test if the relay server is running, open a browser, and enter the URL http://localhost:8010/.

14. Configure the Groove Relay service startup and recovery settings.

®Po0TO

—h

Go to Start>Programs—->Administrative Tools—> Services.

Double-click Groove Relay.

Set Startup type to Automatic.

Go to the Log On tab, and make sure that Log on as: Local System Account is selected.

Configure the Groove Relay service recovery settings options under Logon as: Local System Account
by clicking the check box Allow service to interact with the desktop.

Click the Recovery tab and enter the values in the following table:

Groove Relay Service Recovery Settings |Values

First Failure Restart the Service
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Second Failure Restart the Service

Subsequent Failure Restart the Service
Reset Failure Count 999
Restart service after 1 minute

g. Click Apply, and then click OK.

15. Perform a full restart of the Groove Relay server.

16. When the server has finished booting, log in and verify that the Groove Relay service is running by
opening a browser and entering the URL http://localhost:8010/.
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Appendix A — Test system configuration information
This appendix provides detailed configuration information about each of the test systems and the servers and

client we used in the tests.

Intel vPro with
Intel Core 2 Duo

Intel Pentium D
processor 930

Intel Pentium 4

Intel Pentium 4

processor E6700 ) processor 630 processor (2.8
rsnﬁf:r‘b'zg’r?ss” and | "5 66 GHz Dual- (gfrg"(')zn Bual- | (3.0 GHz) on Intel |  GHz) on Intel
Core) on Intel D945GTP D945GTP D865GBF
DQ965GF therboard motherboard motherboard
motherboard motherboar
General
Processor and OS kernel:
(physical, core, logical) / 1P2C2L / MP 1P2C2L / MP 1P1C2L / MP 1P1C1L/ UP
(UP, MP)
Number of physical y 1 1 1
processors
Srl(r;glees/sDourzl—Core Dual Dual Single Single
Processor HT status NA NA Enabled NA

System Power
Management Policy

High Performance

High Performance

High Performance

High Performance

CPU

BIOS name and version

93.2006.1102.172
8

43.2006.0707.140
5

Vendor Intel Intel Intel Intel

Name Core 2 Duo Pentium D Pentium 4 Pentium 4

Model Number E6700 930 630 NA

Stepping 6 2 3 7

Socket type LGA775 LGA775 LGA775 Socket 478

Core frequency (GHz) 2.66 3.0 3.0 2.8

Front-side bus frequency 1066 800 800 533

(MHz)
32 KB + 32 KB 16 KB + 12 Kuops

L1 Cache (per core) (per core) 16 KB + 12 Kuops | 8 KB + 12 Kuops

L2 Cache 4 MB (shared) go'\r"eB) (2MBper |5 \p 512 KB

Platform

Vendor Intel Intel Intel Intel

r':"uor:]hbe‘;rmard model DQI65GF D945GTP D945GTP D865GBF

Motherboard chipset Intel Q965 Intel 945G Intel 945G Intel i865G

Motherboard revision C1 AD AD A2

number

Motherboard serial BQGF63500GE9 / | LATP61618159/ LATP61618114 / ABBF31715528 /

number AAD41676-305 AAC97837-301 AAC97837-301 AAC28142-401
Intel Intel Intel Intel
C096510J.86A.54 | NT94510J.86A.39 | NT94510J.86A.39 | BF86510A.86A.00

43.2006.0707.140
5

58.P15.04040500
12

BIOS settings

Setup default

Setup default

Setup default

Setup default

Memory module(s)
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Micron

Micron

6.0.6000.16384

6.0.6000.16384

Vendor and model Corsair CM2X512A- Samsung M3

number 6400 SHITOd0AY- SHIT Od0AY- 58L6423F TN-CCC

Type PC2-6400 PC2-5300 PC2-5300 PC3200

Speed (MHz) 800 667 667 400

Speed running in the

system (MHz) 400 333 333 166

Timing/Latency (tCL-

{RCD-tRP-tRASMin) 5-5-5-18 5-5-5-15 5-5-5-15 2.5-3-3-7

Size 1024 MB 1024 MB 1024 MB 1024 MB

Number of memory 2 x 512 MB 2 x 512 MB 2 x 512 MB 2 x 512 MB

modules

Chip organization Double-sided Double-sided Double-sided Double-sided

Channel Dual Dual Dual Dual

Hard disk

Vendor and model Seagate Seagate Seagate Seagate

number ST3808110AS ST380811AS ST380811AS ST3802110A

Size 80 GB 80 GB 80 GB 80 GB

Buffer Size 8 MB 8 MB 8 MB 2 MB

RPM 7200 7200 7200 7200

Type SATA 300 MB/s SATA 150 MB/s SATA 150 MB/s ATA 100

Controller Intel 82801HR Intel 82801GB Intel 82801GB Intel 82801EB
(ICH8) (ICH7) (ICH7) (ICH5)

Driver Intel 6.2.0.2002 Microsoft Microsoft Microsoft

6.0.6000.16384

Operating system

Microsoft Microsoft Microsoft Microsoft
Name Windows Vista Windows Vista Windows Vista Windows Vista
Ultimate RTM Ultimate RTM Ultimate RTM Ultimate RTM
Build number 6000 6000 6000 6000
File system NTFS NTFS NTFS NTFS
Kernel ACPI x86-based ACPI x86-based ACPI x86-based ACPI x86-based
PC PC PC PC
Language English English English English
Microsoft DirectX version DirectX 10 DirectX 10 DirectX 10 DirectX 10
Graphics
Vendor and model Intel GMA 3000 | Intel GMA 950 Intel GMA 950 Intel Extreme
number Graphics 2
Type Integrated Integrated Integrated Integrated
. Intel Q965 Intel 945G Intel 945G
Chipset Express Chipset Express Chipset Express Chipset Intel 865G
BIOS version 1377 1256 1256 1318
Memory size 256 MB Shared 128 MB Shared 128 MB Shared 224 MB
Resolution (for single- 1280 x 1024 x 32 1280 x 1024 x 32 1280 x 1024 x 32 1280 x 1024 x 32
monitor tests) @ 60Hz @ 60Hz @ 60Hz @ 60Hz
Driver Intel 7.14.10.1111 | Intel 7.14.10.1111 | Intel 7.14.10.1111 | Intel 6.14.10.4656
Adaptor for dual display PixelView ADD- PixelView ADD- PixelView ADD- NA
tests 7307-DVI-N 7307-DVI-N 7307-DVI-N

Sound card/subsystem

Vendor and model
number

SigmaTel 92XX
High Definition
Audio

SigmaTel 92XX
High Definition
Audio

SigmaTel 92XX
High Definition
Audio

SoundMAX
Integrated Digital
Audio Device
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Driver

Microsoft
6.0.6000.16386

Microsoft
6.0.6000.16384

Microsoft
6.0.6000.16384

Analog Devices
5.12.1.5410

Ethernet

Vendor and model
number

Intel 82566DM
Gigabit

Intel PRO/1000
PM

Intel PRO/1000
PM

Intel PRO/1000
CT

Driver

Intel 9.6.8.0

Microsoft 9.6.8.0

Microsoft 9.6.8.0

Microsoft 8.1.37.2

Optical drive(s)

Vendor and model

Lite-On DVDRW

Lite-On DVDRW

Lite-On DVDRW

Lite-On DVDRW

number SHW-160P6S SHW-160P6S SHW-160P6S SHW-160P6S
Type DVD-RW DVD-RW DVD-RW DVD-RW
Dual/Single layer Dual Dual Dual Dual
USB ports
# of ports 8 6 6 4
Type of ports (USB1.1,
USB2.0) USB 2.0 USB 2.0 USB 2.0 USB 2.0
IEEE 1394 ports
# of ports 1 1 1 [0
Monitor
Samsung Samsung Samsung Samsung
Model SyncMaster SyncMaster SyncMaster SyncMaster
997DF 997DF 997DF 997DF
Screen size 19” 19” 19” 19”

Figure 12: Detailed system configuration information for each of the test PCs.
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HP Proliant DL320 1U Rack

HP ProLiant DL360 1U Rack
Server G4p

Server Server G3 (Active Directory/DHCP/DNS
(Exchange server)
server)
General
Processor and OS kernel:
(physical, core, logical) / (UP, MP) 1P1C2L /T MP 1P1C2L 7 MP
Number of physical processors 1 1
Single/Dual-Core processors Single Single

System Power Management Policy

AC/Always On

AC/Always On

CPU

Vendor Intel Intel

Name Intel Pentium 4 650 Intel Xeon
Stepping 3 A

Socket type LGA775 mPGA-604

Core frequency (GHz) 3.4 3.4

Front-side bus frequency (MHz) 800 800

L1 Cache 16 KB + 12 Kuops 16 KB + 12 Kuops
L2 Cache 2 MB 2 MB

Platform

Vendor HP HP

Motherboard model number 374295-405 382146-405
Motherboard chipset Intel E7221 Chipset Intel E7520 Chipset
Motherboard revision number A03 A05

Motherboard serial number USE617N1VL USE617N2DF
BIOS name and version HP D18 HP P54

BIOS settings Default Default

Memory module(s)

Vendor and model number

Micron MT18VDDT12872AG-
40BD1

Infineon HYS72T128000HR-5-A

Type PC3200 DDR PC2-3200 DDR-2
Speed (MHz) 400 400

Speed running in the system (MHz) | 200 200
Timing/Latency (tCL-tRCD-iRP-

tRASmn) 3-3-3-8 3-3-3-11

Size 2048 MB 2048 MB
Number of RAM modules 2 2

Chip organization Double-sided Double-sided
Channel Single Single

Hard disk

Vendor and model number Maxtor 6L160MO Maxtor 6L160MO
Number of disks in system 1 1

Size 160GB 160GB

Buffer Size 8 MB 8 MB

RPM 7200 7200

Type SATA SATA

Controller Intel 82801FB (ICH6) Intel 6300ESB (ICH-S)

Controller driver

Microsoft 5.2.3790.1830

Microsoft 5.2.3790.1830

Operating system
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Microsoft Windows Server 2003 R2

Microsoft Windows Server 2003 R2

Name Enterprise Edition Enterprise x64 Edition
Build number 3790 3790

Service Pack SP1 SP1

File system NTFS NTFS

Kernel ACPI Multiprocessor PC ,FA;SPI Multiprocessor x64-based
Language English English

Microsoft DirectX version 9.0c 9.0c

Graphics

Vendor and model number ATl Rage XL ATl Rage XL

BIOS version GR-xlcpg-5.882-4.333 GR-xlcpg-5.882-4.333
Type Integrated Integrated

Memory size 8 MB shared 8 MB shared
Resolution 1024 x 768 1024 x 768

Driver ATI15.10.2600.6014 ATI 6.14.10.6025

Network card/subsystem

Vendor and model number

HP NC7782 Dual-port Gigabit

HP NC7782 Dual-port Gigabit

Server Adapter Server Adapter
Type Integrated Integrated
Driver HP 9.52.0.0 HP 9.52.0.0
Optical drive
Vendor and model number Teac DW-224E-C HLDS GCR-8240N
Type DVD-ROM/CD-RW CD-ROM
USB ports
# of ports 3 2
Type of ports (USB 1.1, USB 2.0) USB 2.0 USB 2.0

Figure 13: Detailed system configuration information for the Exchange and Active Directory/DHCP/DNS servers in our test

confiauration.
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Custom-built server

HP ProLiant DL360 1U rack

SR (Groove Relay server) R (e
(Groove Manager/SQL server)
General
Processor and OS kernel:
(physical, core, logical) / (UP, MP) 2P4CaL 1P1C2L/MP
Number of physical processors 2 1
Single/Dual-Core processors Dual Single

System Power Management Policy

AC/Always On

AC/Always On

CPU

Vendor Intel Intel
Name Dual-Core Intel Xeon processor Intel Xeon
5160

Stepping 4 A
Socket type LGA 771 mPGA-604
Core frequency (GHz) 3.0 3.4
Front-side bus frequency (MHz) 1333 800
L1 Cache 32KB + 32KB 16 KB + 12 Kuops
L2 Cache 4MB (shared by 2 cores) 2 MB
Platform
Vendor Supermicro HP
Motherboard model number X7DB8+ 382146-405
Motherboard chipset Intel 5000P Chipset Intel E7520 Chipset
Motherboard revision number 92 A05
Motherboard serial number TM63S00221 USEG617N2DF

. Phoenix Technologies 6.00
BIOS name and version 5/03/2006 HP P54
BIOS settings Default Default

Memory module(s)

Vendor and model number

Micron MT18HTF12872FDY

Infineon HYS72T128000HR-5-A

Type PC2-4300 PC2-3200 DDR-2
Speed (MHz) 533 400

Speed running in the system

(MHz) 533 200
Timing/Latency (tCL-tRCD-iRP-

{RASMIN) 4-4-4-12 3-3-3-11

Size 8192MB 2048 MB
Number of RAM modules 8 2

Chip organization Double-sided Double-sided
Channel Dual Single

Hard disk

Vendor and model number Hitachi HDT722516DLA38 Maxtor 6L160MO
Number of disks in system 2 1

Size 160GB 160GB

Buffer Size 8MB 8 MB

RPM 7200 7200

Additional disk drive vendor and Western Digital WD800GD NA

model number

Size 80GB NA

Buffer Size 8MB NA
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RPM 10000 NA
Type SATA SATA
Controller Intel 631XESB Serial ATA Intel 6300ESB (ICH-S)

Controller driver

Intel 7.4.0.1005

Microsoft 5.2.3790.1830

Operating system

Name

Microsoft Windows 2003 Server R2
x64 Enterprise Edition

Microsoft Windows Server 2003 R2
Enterprise x64 Edition

Build number 3790 3790

Service Pack SP1 SP1

File system NTFS NTFS

Kernel ACPI Multiprocessor x64-based PC égPl Multiprocessor x64-based
Language English English

Microsoft DirectX version 9.0c 9.0c

Graphics

Vendor and model number ATl Rage XL ATl Rage XL

BIOS version GR-xlints3y.09a-4.332 GR-xlcpg-5.882-4.333
Type Integrated Integrated

Memory size 8 MB shared 8 MB shared
Resolution 1024 x 768 1024 x 768

Driver ATI 6.14.10.6025 ATI 6.14.10.6025

Network card/subsystem

Vendor and model number

Intel PRO/1000 EB Network

HP NC7782 Dual-port Gigabit

Connection Server Adapter
Type Integrated Integrated
Driver Intel 9.5.12.0 HP 9.52.0.0
Optical drive
Vendor and model number LITE-ON SOHC-5236V HLDS GCR-8240N
Type DVD-ROM/CD-RW CD-ROM
USB ports
# of ports 4 2
Type of ports (USB 1.1, USB 2.0) USB 2.0 USB 2.0

Figure 14: Detailed system configuration information for the Groove servers in our test configuration.
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System

Collaboration client

General

Processor and OS kernel: (physical, core, logical) / (UP, MP) 1P1C1L/UP
Number of physical processors 1
Single/Dual-Core processors Single
Processor HT status N/A

System Power Management Policy Balanced
CPU

Vendor Intel

Name Celeron
Model number 325
Stepping 1

Socket type Socket 478
Core frequency (GHz) 2.53
Front-side bus frequency (MHz) 533

L1 Cache 16 KB + 12 Kuops
L2 Cache 256 KB
Platform

Vendor Dell
Motherboard model number OWF887
Motherboard chipset Intel 865G
Motherboard revision number A2
Motherboard serial number 62XTHI1
BIOS name and version Dell AOO
BIOS settings Setup default

Memory module(s)

Vendor and model number

MOSEL V826632K24SCTG-D3

Type PC 3200

Speed (MHz) 400

Speed running in the system (MHz) 166

Timing/Latency (tCL-tRCD-tRP-tRASmin) 2.5-3-3-7

Size 512 MB

Number of memory modules 2 x 256 MB

Chip organization Single-Sided
Channel Dual

Hard disk

Vendor and model number Maxtor 6L160P0
Size 160 GB

Buffer Size 8 MB

RPM 7200

Type ATA 133

Controller Intel 82801EB (ICH5)
Driver Microsoft 6.0.6000.16386
Operating system

Name Microsoft Windows Vista Ultimate RTM
Build number 6000

File system NTFS

Kernel ACPI x86-based PC

Principled Technologies, Inc.: System performance in common
professional find/use/share scenarios in Microsoft Windows Vista

31




Language English

Microsoft DirectX version DirectX 10

Graphics

Vendor and model number Intel Extreme Graphics 2
Type Integrated

Chipset Intel 865G

BIOS version Intel Video BIOS

Memory size 224 MB

Resolution 1280 x 1024 x 32 bit @ 60Hz
Driver Intel 6.14.10.4656

Sound card/subsystem

Vendor and model number

SoundMAX Integrated Digital Audio Device

Driver Analog Devices 5.12.1.7000
Ethernet

Vendor and model number Intel PRO/100+ PCI Adapter
Driver 6.4.14.81

Optical drive(s)

Vendor and model number

Philips DVD-RW DVD8701

Type DVD-RW

Dual/Single layer Dual

USB ports

# of ports 6

Type of ports (USB1.1, USB2.0) 2.0

IEEE 1394 ports

# of ports [0

Monitor

Model ViewSonic Optiquest Q7
Screen size 17”

Figure 15: Detailed system configuration information for the Collaboration client PC, which collaborated with the PC under test via

Microsoft Groove and Microsoft Outlook.
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Appendix B — Instructions for running the application scenarios
We evaluated the performance of each of the test systems on each of the application scenarios (see the
Application scenarios section for more information on them) by hand-timing the tasks in those scenarios.

We collected results for five runs of each scenario in each system configuration. We refer in this paper only to the

median results of those runs on each system configuration. Lower times to complete a given function indicate
better performance. We round those times to hundredths of seconds in this report.

In the following instructions, we assume you have already completed all of the setup work in the Test
Methodology section.

Creating a PDF while running a Windows Defender Custom Scan
The applications involved
This scenario requires two applications:
e Microsoft Office Word 2007
e Windows Defender
The data files involved
This scenario uses two files or folders:
o Office11 Install Guide.doc, a 3.7MB Word document that is the installation guide for Office 2003
e C:\Defender Workload, a 26.4MB folder
The test process
First, prepare each system by following these steps once:

1. Copy the Windows Defender workload to C:\DefenderWorkload1.

2. Make four more copies of this workload, renaming them to DefenderWorkload2 to DefenderWorkload5.

3. Copy the Office11 Install Guide.doc test document to the desktop.
To execute the test, follow these instructions. You will need one stopwatch.

Reboot the system under test.

Log in.

Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.

Open the test Word file.

Launch Windows Defender (Start>All Programs->Windows Defender).

Click the drop-down menu next to Scan in the Windows Defender menu.

Choose Custom Scan from the drop-down menu.

Click the radio button next to Scan selected drives and folders.

Click Select.

0. Browse to the Windows Defender workload directory by expanding C:\ and checking the box next to
DefenderWorkloadn, where n is equal to the current test run.

11. Click OK.

12. Click the Office Button in Word 2007.

13. Left-click the arrow to the right of Save As. A dialog box titled Save a copy of the document will open.

14. Select PDF or XPS.

15. Prepare the stopwatch.

16. Bring Windows Defender to the foreground.

17. Click Scan Now. (Windows Defender reports the time elapsed under Scan Statistics.)

18. When the scan has run for 10 seconds, switch to Word 2007 (alt-Tab), and simultaneously click the

Publish button in the Publish as PDF or XPS dialog box and start the stopwatch.
19. Stop the stopwatch when Adobe Reader 7.08 completes loading the newly created PDF file.
20. Record this time as the PDF creation test's result.
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21. Wait one minute, and then bring Windows Defender to the foreground.

22. Record the scan time Windows Defender reports as the scan time's test result.
23. Delete the newly-created Office11 Install Guide.pdf file.

24. Repeat these steps four more times for a total of five runs.

We report the time, in seconds, that Microsoft Office Word 2007 took to perform the file conversion. We also
report the time, in seconds, that Windows Defender took to perform a scan of the DefenderWorkload directory.
Lower times indicate faster performance and so are better.

Copying a folder on an encrypted volume

The applications involved
The scenario requires one application:

e Windows Vista BitLocker Drive Encryption

The data files involved
This scenario uses one folder:

e BitLocker WL, a 499 MB folder with 307 files

The test process
First, prepare each system by following these steps once:

1. Copy the BitLockerWorkload directory to C:.
2. Make four copies of this directory.
3. Rename these directories BitLockerWorkload1 through BitLockerWorkload5.

Enable TPM in the BIOS
Enable the Trusted Platform Module (TPM) in the BIOS on test systems that support it. Check each motherboard
manufacturer’s instructions for the procedure for enabling TPM.

Turn on TPM in Windows Vista
1. Click Start, and type tpm.msc in the Search box.
2. Press Enter.
3. If the User Account Control dialog box appears, verify that the proposed action is what you requested,
and then click Continue.
4. From the Trusted Platform Module Management screen, click Turn TPM On...

For systems that do not support TPM or systems with a TPM that is incompatible with Windows Vista:

Edit the group policy for BitLocker

1. Click Start, and type gpedit.msc in the Search box.
2. Press Enter.
3. If the User Account Control dialog box appears, verify that the proposed action is what you requested.
4. Click Continue.
5. From the Group Policy Object Editor screen, take the following actions:
a. Click Local Computer Policy.
b. Click Administrative Templates.
c. Click Windows Components.
d. Double-click BitLocker Drive Encryption.
e. Choose Control Panel Setup: Enable Advanced Setup Options.
f.  Change the radio button selection to Enabled.
g. Choose Allow BitLocker without a compatible TPM.
h. Choose Disallow startup key with TPM in the drop-down menu under Configure TPM startup key
option.
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i. Choose Disallow startup PIN with TPM in the drop-down menu under Configure TPM startup PIN
option.
j.  Click OK to change the group policy to use a Startup Key.
6. Click Start, and type gpupdate.exe in the Search box. Press Enter.
7. Wait for the process to finish.

Encrypt the boot partition with BitLocker on systems that do not have a Vista-compatible TPM
Click Start, and type BitLocker in the Search box.
Press Enter.
If the User Account Control dialog box appears, verify that the proposed action is what you requested.
Click Continue.
From the BitLocker Drive Encryption screen, click Turn On BitLocker on the operating system volume.
From the Set BitLocker Startup Preferences screen, choose Require Startup USB Key at every startup.
Insert a USB flash drive in the computer, if one is not already present.
From the Save the user Startup Key dialog box, choose the location of the USB flash drive.
Click Save.
0. In the Save the recovery password dialog box, the following options appear:
e Save the password on a USB drive.
e Save the password in a folder.
e Print the password.
11. Choose the Save the password on a USB drive option to preserve the recovery password.
12. Click Next.
13. From the Encrypt the selected disk volume dialog box, confirm the Run BitLocker System Check box is
unchecked.
14. Click Continue.
15. The Encryption in Progress status bar appears.
16. Encryption is complete when that progress bar disappears. The process required from 30 to 60 minutes
on the test systems.
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Encrypt the boot partition with BitLocker on systems that have a Vista-compatible TPM

Click Start, and type BitLocker in the Search box.

Press Enter.

If the User Account Control dialog box appears, verify that the proposed action is what you requested.

Click Continue.

From the BitLocker Drive Encryption screen, click Turn On BitLocker on the operating system volume.

Insert a USB flash drive in the computer, if one is not already present.

In the Save the recovery password dialog box, the following options will appear:

e Save the password on a USB drive.

e Save the password in a folder.

e  Print the password.

8. Choose the Save the password on a USB drive option to preserve the recovery password.

9. From the Encrypt the selected disk volume dialog box, confirm the Run BitLocker System Check box is
checked.

10. Click Continue.

11. Confirm the user wants to reboot the computer by clicking Restart Now.

12. BitLocker ensures that the system is BitLocker-compatible and ready for encryption as the system
reboots. If the system does not meet those requirements, an error message will alert you to the
problem(s) before encryption starts.

13. Remove the USB key when the system prompts you to do so during reboot.

14. Log in.

15. If the system is ready for encryption, the Encryption in Progress status bar will appear.

16. Encryption is complete when that progress bar disappears. The process required from 30 to 60 minutes

on the test systems.
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To execute the test, follow these instructions. You will need one stopwatch.
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Reboot the system under test.

Log in.

Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
Prepare the stopwatch.

Right-click the BitLockerWorkloadn test folder, where n equals the number of the test run.
Drag the folder to the desktop.

Release the right mouse button.

Simultaneously choose Copy Here from the Windows pop-up and start the stopwatch.
Stop the stopwatch when the dialog box with the progress bar disappears.

10 Record this time as the test's result.

11. Delete the copy of the folder.

12. Repeat these steps four times for a total of five runs.
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We report the time, in seconds, that the system took to make a copy of the folder on an encrypted volume. Lower
times indicate faster performance and so are better.

Opening and editing a Microsoft PowerPoint 2007 presentation

The applications involved
The scenario requires one application:

e Microsoft Office PowerPoint 2007

The data files involved
This scenario uses one file:

e PC Test Results.ppt, a 2.9MB PowerPoint presentation.

The test process
First, prepare each system by following these steps once:

Copy the PC Test Results.ppt test file to the desktop of the system under test.

Open Microsoft Office PowerPoint 2007 by clicking Start->All Programs—>Microsoft Office>Microsoft
Office PowerPoint 2007.

Click the Office Button.

Click PowerPoint Options.

Click Advanced.

In the Display section of the Advanced options for working with PowerPoint dialog box, select Slide Sorter
from the drop-down menu.

Click OK.

Close Microsoft Office PowerPoint 2007.
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This test involves two timed events. To execute the first part of this test, follow these instructions. You will need
one stopwatch.

Opening the file

Reboot the system under test.

Log in.

Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
Prepare the stopwatch.

Simultaneously open the PowerPoint presentation by double-clicking the file on the desktop and start the
stopwatch.

Stop the stopwatch when PowerPoint has completely rendered all the slides.

Record this time as the PowerPoint open time.
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To execute the second part of this test, immediately follow these instructions. You will need one stopwatch.
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Editing the file
1. Change the background in the PowerPoint slide show.
Click View on the PowerPoint menu.
Click Slide Sorter.
Click Design on the PowerPoint menu.
Prepare the stopwatch.
Simultaneously change the slide theme to Apex by clicking the third theme choice on the Design
menu and start the stopwatch.
Stop the stopwatch when the last slide switches to the Apex theme.
Record this time as the PowerPoint background change time.
Close PowerPoint without saving the file.
Repeat these two sets of steps four times for a total of five runs.
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We report the combined time, in seconds, that PowerPoint took to open the presentation and change the design
of the slides. Lower times indicate faster performance and so are better.

Opening a compressed Outlook message attachment, an XML file, in Microsoft Word
2007 while a Groove workspace synchronization runs

The applications involved
The scenario requires three applications:

¢ Microsoft Office Outlook 2007
e  Microsoft Office Word 2007
e Microsoft Office Groove 2007

The data files involved

This scenario uses two files and two folders:

vProC&P0806-XM.xml, a 9.64MB Word document within a 3.92MB compressed folder
Project Photos, a 119MB folder with 50 JPEG images.

Brochure.pdf, a 4.7MB PDF file

Installation.doc, a 3.7MB Word document

The test process
First, prepare each system by following these steps once:

1. Launch Microsoft Groove 2007 on the Collaboration client, which is the PC that will populate the Groove

workspace.

2. On the Collaboration client, add Sheila Craig to Jenny Carlson’s Contact list by performing the following
steps:
a. Click the Contacts tab in the Microsoft Groove Launch bar.
b. Click the New Contact hyperlink. A Find User dialog box will open.
c. Inthe Search For text box, type Sheila Craig’s name.
d. Click Find.
e. Select Sheila Craig’s name from the list.
f.  Click Add.

3. Create a Groove Workspace template on the Collaboration client by performing the following steps:
a. Click the New Workspace link in the Workspaces section of the Microsoft Office Groove Launch bar.
b. In the Create New Workspace dialog box that appears, type ACME Workspace Template in the

Name of Workspace field, and select Standard, if it is not already selected.
c. Click OK. The ACME Workspace Template Workspace will open.
d. Click Add Tools in the Common Tasks area of the Microsoft Office Groove Launch bar in the bottom
right-hand corner of the Workspace.
e. Select all tools from the More Tools dialog box by placing a check next to each tool.
f. Click OK.
g. Select File->Save Workspace As->Template.
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h. Click the Save button in the Save As dialog box to save the template in the default location.

i. Do not make any selections in the Template Options dialog box, and click OK.

j. Close the ACME Workspace Template workspace after it launches.

Make five copies of the vProC&P0806-XMn.xml E-mail test document, where n is equal to the test run.
Create a compressed folder of the five XML test documents by performing the following steps: Right-
click->Send To>Compressed (zipped) Folder.

Attach and send the five compressed XML test documents to Sheila Craig in five separate messages.
Launch Microsoft Office Outlook 2007 on the system under test to verify it has received the five test
messages.

Close Microsoft Office Outlook 2007 on the system under test.

To execute the test, follow these instructions. You will need two stopwatches.

1.

Create a test Workspace named IT Workspace on the Collaboration client by performing the following

steps:

a. Click the New Workspace link in the Workspaces section of the Microsoft Office Groove Launch bar.

b. In the Create New Workspace dialog box that opens, select Template, and select ACME Workspace
Template from the drop-down box.

c. Type IT Workspace in the Name of Workspace field.

d. Click OK. The IT Workspace will open on the Collaboration client.

2. Invite Sheila Craig to the IT Workspace by performing the following steps:

a. Right-click IT Workspace in the Collaboration client’s Microsoft Office Groove Launch bar.

b. Select Invite to Workspace.

c. A Send Invitation dialog box will appear.

d. Select Sheila Craig/ACME from the To: drop-down box.

e. Click the Invite button.

f. A Groove alert will appear near the system tray on the system under test with a hyperlink stating
Invitation for Sheila Craig/ACME from Jenny Carlson/ACME

g. Click the link.

h. In the Respond to Invitation dialog box, click Accept.

i. Allow IT Workspace to sync on the system under test, as indicated by a Groove alert stating “IT
Workspace ready (click to open).”
Click this Groove alert to open the IT Workspace on the system under test.

3. Close the IT Workspace on the system under test.

4. Close Microsoft Office Groove on the system under test by selecting File>Exit. Click Yes when Groove
prompts you.

5. Reboot the system under test.

6. Copy the test files into the Files (Root Folder) Tool in the IT Workspace on the Collaboration client.

7. When the file copy finishes, close Microsoft Office Groove on the Collaboration client by selecting
File>Exit. Click Yes when Groove prompts you.

8. Log in to the system under test.

9. Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.

10. Launch Microsoft Office Outlook 2007 by clicking Start->E-mail—Microsoft Office Outlook.

11. Select the test message for this test run on the system under test.

12. Double-click the zip archive to open it.

13. Prepare both stopwatches.

14. On the system under test, simultaneously launch Microsoft Office Groove 2007 by clicking Start>All
Programs—->Microsoft Office>Microsoft Office Groove 2007 and start the first stopwatch. (On the system
under test, Microsoft Office Groove will begin to sync with the IT Workspace information on the Groove
Relay server.)

15. Highlight the vProC&P0806-XMn.xml document in the email message attachment on the system under
test by clicking the file once.

16. When the Groove launch and sync has run for five seconds on the system under test, simultaneously
press Enter to open the vProC&P0806-XMn.xml document and start the second stopwatch.
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17. Stop the second stopwatch when the vProC&P0806-XMn.xml file-open completes (which is when the
Word page count turns from gray to black in the Status Bar.

18. Record this time as the file-open test's result.

19. Microsoft Office Groove shows the progress of the sync in the Incoming data section along the bottom of
its Launch bar. As the sync progresses, Microsoft Office Groove counts down to zero in megabytes as the
content syncs on the system under test.

20. Stop the second stopwatch when the content sync countdown disappears.

21. Record this time as the Microsoft Office Groove sync test's result. Leave Microsoft Office Groove open.

22. Delete the IT Workspace by performing the following steps:

a. Launch Microsoft Office Groove 2007 on the Collaboration client by clicking Start->All
Programs->Microsoft Office->Microsoft Office Groove 2007.

b. Right-click IT Workspace on the Collaboration client in the Workspaces area of the Microsoft Office
Groove Launch bar.

c. Select Delete>For All Members.

d. Allow this deletion process to complete on the system under test before exiting Microsoft Office
Groove.

e. Reboot the system under test.

23. Repeat these steps four more times for a total of five runs.

We report the time, in seconds, that the XML file took to open from an email attachment. We also report the time,
in seconds, that Microsoft Office Groove took to perform the synchronization of the workspace. Lower times
indicate faster performance and so are better.

.‘ Principled Technologies, Inc.

. . 1007 Slater Road, Suite 250
Principled . Durham, NC 27703
I Tech nologles www.principledtechnologies.com

info@principledtechnologies.com

Principled Technologies is a registered trademark of Principled Technologies, Inc.

Intel, the Intel Logo, Core, Pentium, and vPro are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries. All other product names are the trademarks of their
respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS
TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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